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BAB III 

METODE PENELITIAN 

3.1 Desain Penelitian. 

Suatu penelitian memerlukan adanya metode penelitian karena metode 

penelitian akan memberikan langkah-langkah di dalam melakukan suatu 

penelitian. Penelitian ini dilakukan dengan metode deskriptif dan menggunakan 

teknik survey. Moh. Nazir (2003:3354) mengatakan bahwa: 

Metode deskriptif adalah suatu metode dalam meneliti status sekelompok 
manusia, suatu objek, suatu set kondisi, suatu system pemikiran, ataupun suatu 
kelas peristiwa pada masa sekarang. 

 
Adapun pengertian penelitian survey yang dikemukakan oleh Kerlinger 

(dalam Riduwan, 2008:49) sebagai berikut : 

Penelitian survey adalah penelitian yang dilakukan pada populasi besar 
maupun kecil, tetapi data yang dipelajari adalah data dari sampel yang diambil 
dari populasi tersebut, sehingga ditemukan kejadian-kejadian relatif, distribusi, 
dan hubungan antar variabel sosiologis maupun psikologis. 

 

Menurut analisis dan jenis datanya, penelitian ini merupakan penelitian 

kuantitatif karena data yang disajikan dalam penelitian ini merupakan data yang 

berbentuk angka, sebagaimana dijelaskan oleh Sugiyono (2005:13). “Data 

kuantitatif adalah data yang berbentuk angka atau data kualitatif yang 

diangkakan.” 
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3.2 Operasionalisasi Variabel  

Sugiyono (2007:61) mendefinisikan variabel penelitian sebagai berikut: 

“Variabel penelitian adalah suatu atribut atau sifat atau nilai dari orang. Objek 

atau kegiatan yang mempunyai variasi tertentu yang ditetapkan oleh peneliti untuk 

dipelajari dan kemudian ditarik kesimpulannya.” 

Sedangkan pengertian variabel menurut S. Margono (dalam Nurul zuriah, 

2005:144), ‘Variabel adalah konsep yang mempunyai variasi nilai.’ 

Dalam hal ini yang menjadi variabel adalah Prestasi Belajar.  Prestasi 

belajar adalah suatu bukti keberhasilan belajar peserta didik dalam mempelajari 

pelajaran di sekolah, setelah menempuh rentang waktu tertentu, dalam bentuk 

angka-angka/nilai-nilai yang diperoleh dari hasil tes atau pengukuran suatu 

evaluasi. 

Tabel 3.1 
Operasionalisasi Variabel 

 

VARIABEL DIMENSI INDIKATOR  

Prestasi 

Belajar 
Nilai 

Nilai UAS kelas XI IPS tahun ajaran 2009/2010 

 

Tabel 3.2 
Indikator Angket Gaya Belajar 

 

VARIANS INDIKATOR 
No. 
Item 

Visual 1. Rapi dan teratur  1. 

2. Berbicara dengan cepat perencanaan dan pengaturan jangka 

panjang yang baik. 

2. 
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3. Mengingat apa yang dilihat dari pada di dengar  3. 

4. Teliti terhadap detail  4. 

 5. Mencoret-coret tanpa arti selama berbicara di telpon  5. 

6. Mengingat dengan asosiasi visual 6. 

7. Mempunyai masalah untuk mengingat instruksi verbal 

kecuali jika ditulis dan minta bantuan orang untuk 

mengulang. 

7. 

8. Biasanya tidak terganggu oleh keributan 8. 

9. Tahu apa yang dikatakan tetapi kadang-kadang sulit 

menemukan kata-kata yang cocok. 

9. 

10. Lebih suka melakukan demostrasi daripada berpidato 10. 

Auditori 1. Berbicara pada diri sendiri saat bekerja 13. 

2. Mudah terganggu dengan keributan 14. 

3. Menggerakan bibir mereka dan mengucapkan tulisan di buku 

ketika membaca 

15. 

4. Senang membaca dengan keras dan mendengarkan 16. 

5. Dapat mengulangi kembali dan menirukan nada, birama. 17. 

6. Merasa kesulitan untuk menulis, tetapi hebat dalam bercerita 18. 

7. Biasanya berbicara dengan fasih 19. 

8. Lebih suka music daripada seni 20. 

9. Belajar dengan mendengarkan dan mengingat apa yang 

didiskusikan daripada dilihat 

21. 

10. Suka berbicara, suka berdiskusi, dan menjelaskan sesuatu 

panjang lebar. 

22. 

11. Efektif jika belajar bersama-sama daripada belajar sendiri 23. 

12. Mudah mengatakan apa yang sedang dipikirkannya namun 

sulit menuanglkannya dalam bentuk tertulis 

24. 

Kinestetik 1. Berdiri dekat ketika berbicara dengan orang 25. 
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2. Selalu berorientasi pada fisik dan banyak bergerak 26. 

3. Belajar melalui memanipulasi dan praktik 27. 

4. Menghapal dengan cara berjalan dan melihat  

5.  Menggunakan jari sebagai penunjuk ketika membaca 29. 

6. Tidak dapat duduk diam untuk 

waktu lama 

30. 

7. Banyak melakukan aktifitas fisik ringan saat berbicara atau 

belajar 

31. 

8. Selalu berpindah-pindah tempat saat belajar 32. 

9. Mengingat sesuatu menjadi lebih baik apabila sambil berjalan 

atau menggerakkan bagian tubuh tertentu 

33. 

10. Lebih suka “trial&error” jika mencoba sesuatu alat yang baru 34. 

11. Tulisan tangan kurang bagus. 35. 

 

 

3.3 Populasi dan Sampel 

3.3.1 Populasi  

Menurut Sugiyono (2007:117) “Populasi adalah wilayah generalisasi yang 

terdiri atas objek/subjek yang mempunyai kualitas dan karakteristik tertentu yang 

ditetapkan oleh peneliti untuk dipelajari dan kemudian ditarik kesimpulan.” 

Nurul Zuriah (2006:116) mengemukakan bahwa “Populasi adalah seluruh 

data yang menjadi perhatian peneliti dalam ruang lingkup dan waktu yang 

ditentukan.” 

Sedangkan Moh. Nazir (2003:273) mengemukakan bahwa “Populasi 

adalah kumpulan dari ukuran-ukuran tentang sesuatu yang ingin kita buat 

inferensi.” 
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Dalam penelitian ini populasinya adalah seluruh siswa/ siswi SMAN 10 

Bandung kelas XI IPS tahun pelajaran 2009/2010 yang berjumlah 189 orang. 

3.3.2 Sampel 

Sugiyono (2007:118) mengatakan bahwa “Sampel adalah bagian dari 

jumlah dan karakteristik yang dimiliki oleh populasi tersebut.” Adapun sampelnya 

diambil secara acak (Random Sampling). Riduwan (2008:58) mengatakan bahwa 

“Simple Random Sampling adalah cara pengambilan sampel dari anggota populasi 

dengan menggunakan acak tanpa memperhatikan strata (tingkatan) dalam anggota 

populasi tersebut.”  

Dalam pengambilan sampel dari populasi, peneliti hendaklah menentukan 

terlebih dahulu berapa jumlah responden yang akan dijadikan sampel dalam 

penelitian ini. Teknik pengambilan sampel menggunakan rumus Slovin (Riduwan, 

2004:65) sebagai berikut : 

� =
�

�����
  

 Dimana  : n  = Ukuran sampel keseluruhan 
      N = Ukuran populasi 
      �  = Persen kelonggaran ketidaktelitian karena kesalahan  

 Sehingga, � =
�

�����
 

       � =
�
�

���
��
,
���
 

       � =
189

1+189�0,0025�
 

 � =
�
�

�,����
 

 � = 128 responden 
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Setelah diperoleh sampel siswa maka langkah selanjutnya adalah 

menentukan sampel setiap kelas untuk seluruh kelas. Dalam penarikan 

sampel kelas dilakukan secara proporsional.  Dalam penarikan sampel 

Riduwan, (2004:22-23) siswa dilakukan secara proporsional yang dapat 

dihitung dengan rumus : 

ni = Ni / N.n 

          Dimana : 

  ni : Jumlah sampel menurut kelas 
  n : Jumlah sampel seluruh 
  Ni : Jumlah populasi menurut kelas 
  N : Jumlah populasi seluruhnya 

Perhitungannya dapat dilihat dalam tabel sebagai berikut: 

Tabel 3.3  
Sampel Siswa Kelas XI IPS 

 
No Sekolah Jumlah 

Siswa  
 

Sampel Siswa 

1 IPS 1 39    �
�� 

��

� �

 ! 128 = 26  

2 IPS 2 38 �
�� 

#

�
�

 ! 128 = 26 

3 IPS 3 39 �
�� 

#�
�
�

 ! 128 = 26 

4 IPS 4 35 �
�� 

#�
�
�

 ! 128 = 24 

5 IPS 5 38 �
�� 

#

�#


 ! 128 = 26 

Jumlah 189 128 
 

Dari 189 siswa akan diambil sampel sebanyak 128 siswa dengan 

cara random. 

Sebelum penyebaran angket dilakukan, sampel yang akan 

menerima angket harus dikocok/diundi terlebih dahulu sesuai dengan 

jumlah angket yang akan disebar agar adil.  
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3.4 Teknik Pengumpulan Data 

Untuk mengumpulkan data yang diperoleh dalam penelitian ini, maka 

penulis menggunakan beberapa tehnik pengumpulan data : 

1. Angket  

Teknik angket adalah teknik pengumpulan data melalui penyebaran 

seperangkat pertanyaan ataupun pernyataan tertulis kepada siswa kelas XI IPS 

tahun ajaran 2009/2010 di SMAN 10 Bandung yang dijadikan responden.  

Menurut Nurul Zuriah (2006:182), Angket adalah suatu alat pengumpulan 

informasi dengan cara menyampaikan sejumlah pertanyaan tertulis untuk dijawab 

secara tertulis pula oleh responden.  Angket ini diberikan kepada siswa untuk 

memperoleh informasi mengenai gaya belajar yang dimiliki oleh siswa itu sendiri.  

2. Studi Dokumentasi 

Peneliti mencari data tentang prestasi belajar siswa, yaitu nilai UAS pada 

mata pelajaran Akuntansi pada tahun ajaran 2009/2010. 

 

3.5  Teknik Pengujian Instrumen 

“ Di dalam penelitian data mempunyai peran yang amat penting, karena data 
merupakan penggambaran variabel yang diteliti, dan berfungsi sebagai alat 
pembuktian hipotesis. Oleh karena itu benar tidaknya data, sangat menentukan 
bermutu tidaknya hasil penelitian. Sedangkan benar tidaknya data, tergantung 
dari baik tidaknya instrumen pengumpulan data”. (Suharsimi Arikunto, 
2006:168) 

 
3.5.1 Uji Validitas 

 Dalam penelitian ini pengujian validitas dilakukan dengan cara pengujian 

validitas eksternal. Di mana sebuah instrumen dikatakan valid apabila mampu 

mengukur apa yang diinginkan serta dapat mengungkapkan data dari variabel 
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yang diteliti secara tepat. Suharsimi Arikunto berpendapat “Instrumen dengan 

validitas eksternal dapat dicapai apabila data yang dihasilkan tersebut sesuai 

dengan data atau informasi mengenai variabel penelitian yang dimaksud.” Adapun 

rumus yang digunakan untuk menguji validitas ini adalah  dengan menggunakan 

rumus koefisien korelasi Product Moment dari Pearson (Suharsimi 

Arikunto,2007:72) sebagai berikut : 

                               

 

 

Keterangan : 
rxy            = Koefisien Korelasi butir 

∑X      = Jumlah skor tiap item angket 

∑Y      = Jumlah skor total item angket 

∑ XY
 

= Jumlah perkalian skor X dan Y 

( )2X∑   = Jumlah skor-skor X yang dikuadratkan 

( )2Y∑    = Jumlah skor-skor Y yang dikuadratkan 
  N  = Jumlah sampel 

 
Besarnya koefisien validitas diinterpretasikan untuk menyatakan kriteria 

validitas butir angket yang selengkapnya diuraikan sebagai berikut : 

Setelah diperoleh nilai rxy selanjutnya dikonsultasikan dengan nilai rtabel  

dengan taraf signifikan 5%. Jika didapatkan nilai rxy> rtabel, maka butir instrumen 

dapat dikatakan valid, akan tetapi sebaliknya jika nilai rxy < rtabel, maka dikatakan 

bahwa instrumen tersebut tidak valid. (Sugiyono, 2007:182).  

 Adapun prosedur penghitungan validitas uji coba instrumen yaitu dengan 

menggunakan bantuan Excel Windows. 

 

rxy  = 
( )( )

( ) }{{ }2222 YYNXXN

YXxyN

∑−∑∑−∑

∑∑−∑
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3.5.2 Uji Reliabilitas 

Reliabilitas menunjukan suatu pengertian bahwa suatu instrumen cukup 

dapat dipercaya untuk digunakan sebagai alat pengumpul data. Instrumen yang 

baik adalah instrumen yang dapat dengan ajeg memberikan data yang sesuai 

dengan kenyataan. (Suharsimi Arikunto, 2006:178) 

Untuk menguji reliabilitas angket ini, digunakan metode Alpha (r11) 

dengan rumus dan langkah perhitungan (Suharsimi Arikunto, 2006 : 196) sebagai 

berikut: 

Langkah 1: Mencari varian tiap butir 

 
 
 
 
 
 

Keterangan: 
σb

a  = Harga varians tiap butir 
∑X2  = Jumlah kuadrat jawaban responden dari setiap item 
(∑X) 2 = Jumlah skor seluruh responden dari setiap item 
 N = Jumlah responden 

 
Langkah 2: Menghitung varian total (Suharsimi Arikunto, 2006: 196) 

 
 

  

 

 
Keterangan : 
σt

a  = Harga varians total 
∑Y2 = Jumlah kuadrat jawaban responden dari seluruh  item 
(∑Y) 2 = Jumlah skor seluruh responden dari seluruh item 
N = Jumlah responden 
 

N
N

X
X

a
b

∑
∑−

=

2
2

)(

σ  

N
N

Y
Y

a
t

∑ ∑−
=

2
2 )(

σ
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Langkah 3. Menghitung reliabilitas instrumen dengan rumus Alpha (Suharsimi    
Arikunto, 2006 : 196) 

 

 
 

 
 
Keterangan : 
r11 = Reliabilitas Instrument 
k = Banyak item/ butir pertanyaan 
%&

2 = Harga varian item/butir 

%'
2 = Harga varians total 

 

Setelah diperoleh nilai r11  selanjutnya dikonsultasikan dengan nilai rtabel  

dengan taraf signifikan 5%. Jika didapatkan nilai r11>rtabel, maka butir instrumen 

dapat dikatakan reliabel, akan tetapi jika nilai r11<rtabel, maka dikatakan bahwa 

instrumen tersebut tidak reliabel. (Suharsimi Arikunto,2006:198).  

 Dalam penelitian ini, untuk perhitungan reliabilitas, penulis menggunakan 

bantuan software Excel Windows. 

 

3.6 Analisis Data dan Pengujian Hipotesis 

Teknik analisa data merupakan cara yang digunakan untuk menguraikan 

keterangan-keterangan atau data yang diperoleh agar data tersebut dapat dipahami 

bukan oleh orang yang mengumpulkan data saja, tapi juga oleh orang lain. 

Adapun langkah-langkah yang ditempuh adalah sebagai berikut : 

1. Editing 

Dalam pengolahan data yang pertama kali harus dilakukan adalah editing. 

Ini berarti bahwa semua angket harus diteliti satu persatu tentang kelengkapan dan 

kebenaran pengisian angket sehingga terhindar dari kekeliruan dan kesalahan.  













−
−

= ∑
σ

σ
2

2

11 1
1

t

b

k

k
r  
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2. Uji Normalitas  

Tujuan dari dilakukannya uji normalitas tentu saja untuk mengetahui 

apakah suatu variabel normal atau tidak. Normal disini dalam arti mempunyai 

data distribusi yang normal. Normal atau tidaknya berdasarkan patokan distribusi 

normal dari data dengan mean dan standar deviasi yang sama. Jadi uji normalitas 

pada dasarnya melakukan perbandingan antara data yang kita miliki dengan data 

berdistribusi normal yang memiliki mean dan standar deviasi yang sama dengan 

data kita. 

Data yang mempunyai distribusi normal merupakan salah satu syarat 

dilakukannya tes parametrik. Untuk data yang tidak mempunyai distribusi tentu 

saja analisisnya harus menggunakan tes non parametrik.  

Data yang mempunyai distribusi yang normal berarti mempunyai sebaran 

yang normal pula. Dengan profil data semacam ini maka data tersebut dianggap 

bias mewakili populasi 

Untuk mengetahui apakah data yang kita miliki normal atau tidak, secara 

kasat mata kita bisa melihat histogram dari data yang dimaksud, apakah 

membentuk kurva normal atau tidak. Tentu saja cara ini sangat subjektif. Untuk 

mendapatkan histogram dengan dilengkapi dengan garis distribusi normal 

pengujian untuk uji normalitas dilakukan dengan menggunakan SPSS 16 dengan 

menggunakan analisis P-P & Q-Q Plot yang merupakan analisis plot grafik 

probabilitas secara umum yang digunakan untuk menetapkan apakah distribusi 

suatu variabel tertentu sesuai dengan variabel yang telah ditetapkan, Pengujian ini 

dapat dilakukan dengan langkah-langkah sebagai berikut : 
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1. Buka file yang akan dianalisis. 

2. Klik Analyze => Descruptive Statistics => P-P Plot dan atau Q-Q Plot 

pada menu sehingga kotak dialog explore muncul. 

3. Masukkan variabel pada kotak Variables. Secara default pada Test 

Distribution terpilih model Normal. 

4. Klik OK  

3. Pengklasifikasian Data Berdasarkan Gaya Belajar 

1. Data yang telah diperoleh melalui angket, kemudian dianalisis sehingga 

dapat diperoleh kecenderungan gaya belajar pada masing-masing siswa. 

2. Sajikan data dengan membuat Tabel Distribusi Frekuensi untuk 

mempermudah pengolahan data. 

4. Pengujian Hipotesis 

Adapun yang dilakukan untuk menguji hipotesis adalah dengan 

menggunakan Analisis Varians (Analysis of Variance). Analisis Varians (Analysis 

of Variance) merupakan sebuah teknik inferensial yang digunakan untuk menguji 

perbedaan rerata nilai. Sebagai sebuah teknik analisis, teknik analisis varian ini 

seringkali disebut dengan ANAVA/ANOVA. Suharsimi Arikunto (1997) 

mengemukakan bahwa analisis variansi digunakan untuk menguji hipotesis yang 

berkenaan dengan perbedaan dua mean atau lebih. 

Adapun langkah-langkah penghitungan ANAVA dalam SPSS 16 adalah 

sebagai berikut : 

1. Sebelum melakukan analisis ANOVA, peneliti harus membobot pada 

kolom jumlah dengan langkah-langkah sebagai berikut : 
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a. Buka file data yang akan di bobot. 

b. Klik Data => Weight (Akses pada menu sehingga kotak dialog Weight 

Cases muncul ). 

c. Pilih Weight Cases by.  Pada kotak Frequency Variable, masukkan 

variabel jumlah frekuensi. 

d. Klik OK.  

2. Buka file data yang akan dianalisis 

3. Klik Analyze => Compare Means => One-Way ANOVA pada menu. 

4. Masukkan variabel Gaya Belajar pada kotak Dependent List dan masukkan 

variabel Prestasi Belajar pada kotak Factor. 

5. Klik Option dan pilih Descriptive dan Homogenety of variance test. 

6. Klik Continue sehingga kembali ke kotak dialog One-Way ANOVA 

7. Klik OK    

Jika : 

F hitung ≥ F tabel maka Ho ditolak 

F hitung ≤ F tabel maka  Ho diterima 

 

5. Hipotesis Statistik 

Peneliti mengajukan hipotesis statistik sebagai berikut : 

Ho : (� = (� = (#,  Tidak ada perbedaan gaya belajar siswa (Visual, Auditori, 

dan Kinestetik) dalam prestasi belajar siswa pada mata 

pelajaran akuntansi di SMAN 10 Bandung. 

Ha  : (� ≠ (� ≠ (#, Ada perbedaan gaya belajar siswa (Visual, Auditori, dan 

Kinestetik) dalam prestasi belajar siswa pada mata 

pelajaran akuntansi di SMAN 10 Bandung. 


